
Third Party System Management
Integration Solution

Sun Servers Integration 2.3 for Microsoft System Center
Operations Manager 2007

Supported servers:

 Sun Fire x64 Servers

 Sun Blade x64 Server Modules

A complete list of currently supported Sun servers, service processors, and 
service processor firmware is available at the following web site:

http://www.sun.com/system-management/tools.jsp

Please consult this web site before configuring the Sun Servers Integration 2.3 
for Microsoft System Center Operations Manager 2007.

Sun Microsystems, Inc.

www.sun.com

Part No. 820-2771-16

November 2009, Revision A

http://www.sun.com/system-management/tools.jsp


Copyright 2009 Sun Microsystems, Inc., 4150 Network Circle, Santa Clara, California 95054, U.S.A. All rights reserved.

Sun Microsystems, Inc. has intellectual property rights relating to technology that is described in this document. In particular, and 
without limitation, these intellectual property rights may include one or more of the U.S. patents listed at http://www.sun.com/patents 
and one or more additional patents or pending patent applications in the U.S. and in other countries.

This document and the product to which it pertains are distributed under licenses restricting their use, copying, distribution, and 
decompilation. No part of the product or of this document may be reproduced in any form by any means without prior written 
authorization of Sun and its licensors, if any. Third-party software, including font technology, is copyrighted and licensed from Sun 
suppliers.

Parts of the product may be derived from Berkeley BSD systems, licensed from the University of California. UNIX is a registered 
trademark in the U.S. and in other countries, exclusively licensed through X/Open Company, Ltd.

Sun, Sun Microsystems, the Sun logo, Sun Blade, and Solaris are trademarks or registered trademarks of Sun Microsystems, Inc., or 
its subsidiaries, in the U.S. and in other countries.

U.S. Government Rights—Commercial use. Government users are subject to the Sun Microsystems, Inc. standard license agreement 
and applicable provisions of the FAR and its supplements.

DOCUMENTATION IS PROVIDED "AS IS" AND ALL EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS AND 
WARRANTIES, INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE OR NON-INFRINGEMENT, ARE DISCLAIMED, EXCEPT TO THE EXTENT THAT SUCH DISCLAIMERS ARE 
HELD TO BE LEGALLY INVALID.

Copyright 2009 Sun Microsystems, Inc., 4150 Network Circle, Santa Clara, California 95054, États-Unis. Tous droits réservés.

Sun Microsystems, Inc. possède les droits de propriété intellectuels relatifs à la technologie décrite dans ce document. En particulier, 
et sans limitation, ces droits de propriété intellectuels peuvent inclure un ou plusieurs des brevets américains listés sur le site 
http://www.sun.com/patents, un ou les plusieurs brevets supplémentaires ainsi que les demandes de brevet en attente aux les États-
Unis et dans d’autres pays.

Ce document et le produit auquel il se rapporte sont protégés par un copyright et distribués sous licences, celles-ci en restreignent 
l’utilisation, la copie, la distribution, et la décompilation. Aucune partie de ce produit ou document ne peut être reproduite sous aucune 
forme, par quelque moyen que ce soit, sans l’autorisation préalable et écrite de Sun et de ses bailleurs de licence, s’il y en a.

Tout logiciel tiers, sa technologie relative aux polices de caractères, comprise, est protégé par un copyright et licencié par des 
fournisseurs de Sun.

Des parties de ce produit peuvent dériver des systèmes Berkeley BSD licenciés par l’Université de Californie. UNIX est une marque 
déposée aux États-Unis et dans d’autres pays, licenciée exclusivement par X/Open Company, Ltd.

Sun, Sun Microsystems, le logo Sun, Sun Blade, et Solaris sont des marques de fabrique ou des marques déposées de Sun 
Microsystems, Inc., ou ses filiales, aux États-Unis et dans d’autres pays.

LA DOCUMENTATION EST FOURNIE "EN L’ÉTAT" ET TOUTES AUTRES CONDITIONS, DÉCLARATIONS ET RANTIES 
EXPRESSES OU TACITES SONT FORMELLEMENT EXCLUES DANS LA LIMITE DE LA LOI APPLICABLE, Y COMPRIS 
NOTAMMENT TOUTE GARANTIE IMPLICITE RELATIVE À LA QUALITÉ MARCHANDE, À L’APTITUDE À UNE 
UTILISATION PARTICULIÈRE OU À L’ABSENCE DE CONTREFAÇON.

http://www.sun.com/patents
http://www.sun.com/patents


Contents

Preface..................................................................................................................1 

How this Document is Organized................................................................1 

Before You Read This Document..................................................................1 

Typographic Conventions..............................................................................2 

Terms and Definitions....................................................................................2 

Introduction.........................................................................................................3 

Getting Started.................................................................................................3 

Requirements...................................................................................................6 

Choosing a Configuration Procedure...........................................................6 

Configuring Windows Server 2003 SP1 or SP2.......................................6 

Configuring Windows Server 2003 R2 or R2 SP2...................................7 

Configuring Windows Server 2008...........................................................7 

Configuring Monitored Nodes........................................................................8 

Installing the Sun IPMI Driver......................................................................8 

Verifying the Sun IPMI driver is Correctly Installed.............................10 

Installing the ipmievd Windows Service.....................................................11 

Verifying the ipmievd Service is Correctly Installed.............................13 

Installing the Microsoft IPMI Driver and Provider....................................15 

Verifying the Microsoft IPMI Driver is Correctly Installed..................17 

Deploying Sun Servers Integration 2.3..........................................................20 

Downloading the Sun Servers Integration 2.3............................................20 

Installing Sun Servers Integration 2.3...........................................................20 

Uninstalling Sun Servers Integration 2.3.....................................................23 

Verifying Configuration.................................................................................25 

Verifying Configuration Manually...........................................................25 

Verifying Configuration Remotely Using IPMItool...............................26 

Monitoring Sun x64 servers in Operations Manager..................................29 

Discovering Sun x64 Servers.........................................................................29 

Changing the Frequency of Server Discovery........................................31 

Sun x64 Servers Specific Views.....................................................................33 

iii



Servers State View.......................................................................................33 

Events View..................................................................................................37 

Active Alerts View......................................................................................38 

Health Explorer...........................................................................................38 

Task Status View.........................................................................................40 

Troubleshooting.................................................................................................41 

Sun x64 Servers not Discovered................................................................41 

Release Notes...............................................................................................42 

iv    Sun Servers Integration 2.3 for Microsoft System Center Operations Manager 2007



CHAPTER    1  

Preface

The Sun Servers Integration 2.3 for Microsoft System Center Operations 
Manager 2007 enables you to monitor and manage your Sun x64 servers. This 
document explains how to install the required software on your Sun x64 
servers and Blade modules, how to install the Sun Servers Integration 2.3 and 
how to use the Sun-specific features in Microsoft System Center Operations 
Manager 2007 (hereafter Operations Manager).

─────
How this Document is Organized
This document contains the following sections: 

 Introduction provides an overview of how to install Sun Servers
Integration 2.3

 Configuring Monitored Nodes explains how to install the drivers 
and tools necessary to enable you use Sun Servers Integration 2.3 to 
monitor your Sun x64 servers in Operations Manager

 Deploying Sun Servers Integration 2.3 explains how to install the 
Sun Servers Integration 2.3 into Operations Manager

 Monitoring Sun x64 servers in Operations Manager explains how to 
use the Sun-specific tools provided by Sun Servers Integration 2.3

 Troubleshooting provides notes about how to resolve any problems 
you may have discovering Sun x64 servers as well as any release 
notes about Sun Servers Integration 2.3

This document is intended for experienced IT professionals, field sales 
representatives and support engineers.

─────
Before You Read This Document
To fully understand the information provided in this document and perform 
the tasks discussed, you should use it in conjunction with the documentation 
and on-line help that is supplied with Operations Manager.
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─────
Typographic Conventions
The following typographic conventions are used in this document:

Typeface Meaning Examples

AaBbCc1234 Elements written as seen on 
screen.

Click the File menu.

Select Open -> New.

AaBbCc1234 Code that you type. cd ..

AaBbCc1234 Hyperlink to an external web 
site.

www.sun.com

AaBbCc1234 Cross reference within this 
document.

See Installing for more 
information.

─────
Terms and Definitions
The following terms are used in this manual:

Term Definition

IPMI Intelligent Platform Management Interface

ILOM Integrated Lights Out Manager

ipmievd Windows 
service

A service that listens for events from the BMC that are 
being sent to the SEL and writes them to the Windows 
Application log

SP Service Processor

Sun x64 server Any Sun x64 server or Blade module listed as supported 
on the following web page:

http://www.sun.com/system-management/tools.jsp
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CHAPTER     2     

Introduction

The Sun Servers Integration 2.3 extends the capabilities of Microsoft System 
Center Operations Manager 2007 by providing Sun-specific configuration 
information, product knowledge and tasks. Microsoft System Center 
Operations Manager 2007 (Operations Manager) is a tool designed to provide 
comprehensive system management capabilities in your data center.

─────
Getting Started
The latest version of the Sun Servers Integration 2.3 can be downloaded from 
the following web page:

http://www.sun.com/system  -  management/tools.jsp  

Once you have installed the Sun Servers Integration 2.3 to Operations 
Manager, you can take advantage of the following features in Operations 
Manager.

 You can monitor your Sun x64 servers in Operations Manager, 
viewing alerts, events, the server's state and the state of any tasks.
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Once you have discovered your Sun x64 servers, you can take advantage of 
the following Sun-specific features in Operations Manager.

 You can use Sun-specific tasks, such as launching a remote desktop 
connection or opening the server's Microsoft Management Console.

 You can control a Sun x64 server's ILOM service processor.
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 You can view detailed information about each event or alert 
received from supported and discovered Sun x64 servers.
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─────
Requirements
A complete list of the currently supported Sun servers, operating systems, 
service processors and service processor firmware is available at the following 
web site:

http://www.sun.com/systemmanagement/tools_supportmatrix.jsp?
display=SCOM#SCOM

Please consult the list of supported servers at this website before installing 
Sun Servers Integration 2.3.

Each Sun x64 server you want to monitor in the Operations Manager must 
have an IPMI driver installed. For more information see Choosing a
Configuration Procedure.

─────
Choosing a Configuration Procedure
The exact configuration procedure that you should follow to enable a Sun x64 
server to be monitored using the Sun Servers Integration 2.3 depends on the 
version of Windows Server that is installed on the server.

The following sections explain the different configuration procedures for 
Microsoft Windows Server 2003 SP1 or SP2, Windows Server 2003 R2 or 
Windows Server 2008.

Configuring Windows Server 2003 SP1 or 
SP2
This section describes how to configure Sun x64 servers running Windows 
Server 2003 SP1 or SP2 to enable Operations Manager to manage the 
hardware. Windows Server 2003 SP1 or SP2 use the Sun IPMI driver and the 
impievd Windows service.

To enable hardware monitoring of Microsoft Windows Server 2003 SP1 or SP2 
follow these steps in the order they are shown:

 Install the Sun IPMI driver by following the procedure in Installing
the Sun IPMI Driver

 Optionally verify the Sun IPMI driver is correctly installed by 
following the procedure in Verifying the Sun IPMI driver is
Correctly Installed

 Install the ipmievd Windows service by following the procedure in 
Installing the ipmievd Windows Service
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 Optionally verify the ipmievd Windows service is correctly 
installed by following the procedure in Verifying the ipmievd
Service is Correctly Installed 

Configuring Windows Server 2003 R2 or 
R2 SP2
This section describes how to configure Sun x64 servers running Windows 
Server 2003 R2 or Windows Server 2003 R2 SP2 to enable Operations Manager 
to manage the hardware. In these versions of Windows Server 2003 the 
Hardware Management Feature (including the Microsoft IPMI driver and 
provider) is provided by Microsoft. However, this feature is not installed by 
default and must be installed and enabled additionally.

To enable hardware monitoring of Microsoft Windows Server 2003 R2 or R2 
SP2 follow these steps in the order they are shown:

 Install the Microsoft IPMI driver and provider by following the 
procedure in Installing the Microsoft IPMI Driver and Provider

 Optionally verify the Microsoft IPMI driver is correctly installed by 
following the procedure in Verifying the Microsoft IPMI Driver is
Correctly Installed

 Install the ipmievd Windows service by following the procedure in 
Installing the ipmievd Windows Service

 Optionally verify the ipmievd Windows service is correctly 
installed by following the procedure in Verifying the ipmievd
Service is Correctly Installed

Configuring Windows Server 2008
This section describes how to configure Sun x64 servers running Windows 
Server 2008 to enable Operations Manager to manage the hardware.

To enable hardware monitoring of Microsoft Windows Server 2008 follow this 
procedure:

 Install the ipmievd Windows service by following the procedure in 
Installing the ipmievd Windows Service

 Optionally verify the ipmievd Windows service is correctly 
installed by following the procedure in Verifying the ipmievd
Service is Correctly Installed
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CHAPTER       3  

Configuring Monitored Nodes

This section explains the how to install and configure the software necessary 
on your your Sun x64 servers, which you want to monitor as nodes in 
Operations Manager. The various versions of Windows Server require 
different procedures. For information on which procedure is appropriate for 
the version of Windows Server on your Sun x64 server, please see:

 Configuring Windows Server 2003 SP1 or SP2

 Configuring Windows Server 2003 R2 or R2 SP2

 Configuring Windows Server 2008

─────

Installing the Sun IPMI Driver
This section describes how to install the Sun IPMI driver to enable hardware 
management of a Sun x64 server.

Ensure that you have one of the following Windows operating systems 
installed on your Sun x64 server.

 Microsoft Windows Server 2003 SP1

 Microsoft Windows Server 2003 SP2

Note - If Windows Server 2003 R2, Windows Server 2003 R2 SP2 or Windows 
Server 2008 is installed on the server, follow the steps described in either 
Configuring Windows Server 2003 R2 or R2 SP2 or Configuring Windows
Server 2008.

Before you start, make sure you have downloaded the latest Sun IPMI System 
Management Driver for Server 2003 prior to R2 package from:

http://www.sun.com/system-management/tools.jsp

Uncompress the Sun IPMI System Management Driver for Server 2003 prior to R2 
package locally on the server to be monitored.

To install the Sun IPMI driver:

1. On the server you want to monitor, click Start -> Control Panel -> Add 
Hardware to display the Add Hardware Wizard, then click Next.
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2. Select the Yes, I have already connected the hardware radio button, 
then click Next. The following dialog opens.

3. Select Add a new hardware device, then click Next.

4. Select the Install the hardware that I manually select from a list 
(Advanced) radio button, then click Next.

5. In the following dialog select the System Devices option from the list, 
then click Next.
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6. At the device driver selection click on Have Disk. Click Browse in the 
next dialog and navigate to the folder you uncompressed the Sun IPMI 
System Management Driver for Server 2003 prior to R2 package to. Click 
the ISM.INF driver file, then click OK to proceed.

7. Choose Next, then click Next again to start the driver installation.

The Sun IPMI driver is now successfully installed.

─────

Verifying the Sun IPMI driver is Correctly 
Installed
To verify that the Sun IPMI driver is installed, choose Start -> Control Panel 
-> System -> Hardware and open the Device Manager, as shown in the 
following image.
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Verify that the Sun IPMI System Management Driver v2.1 is included in the 
list of system devices and that no problems are indicated.

─────
Installing the ipmievd Windows Service
This section describes how to install the ipmievd Windows service on a Sun 
x64 server.

The ipmievd Windows service is responsible for periodically polling the 
System Event Log, which is located on the service processor of the monitored 
server and updating the Windows Application Log with new hardware 
events.
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Note - The ipmievd Windows service uses either the Sun IPMI driver or the 
Microsoft IPMI to communicate with the service processor. Before starting, 
please make sure that you have properly installed the appropriate IPMI driver 
for the operating system on your server, as described in Choosing a
Configuration Procedure.

The ipmievd Windows service is a part of the IPMItool for Microsoft Windows 
2003. Before you start, make sure you have downloaded the latest IPMItool for  
Microsoft Windows 2003 package from:

http://www.sun.com/system-management/tools.jsp

Uncompress the IPMItool for Microsoft Windows 2003 package locally on the 
server to be monitored.

To install the ipmievd Windows service:

1. On the server that you want to monitor, open a command prompt 
window and change to the folder where you uncompressed the IPMI 
tool.

2. Depending on the installed operating system choose one of the 
following:

 On Windows Server 2003 SP1 or SP2 install the ipmievd Windows 
service by typing the following command:

ipmievd.exe -i "-I ism sel"

 On Windows Server 2003 R2 or Windows Server 2008 install the 
ipmievd Windows service by typing the following command:

ipmievd.exe -i "-I ms sel"

The ipmievd Windows service is installed on to the server.

3. To start the ipmievd Windows service, type the following command:

net start ipmievd

The ipmievd Windows service should report starting successfully.

4. The ipmievd Windows service is now successfully installed and 
running. You can verify this by clicking Start -> Administrative Tools 
-> Services.
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Locate the ipmievd Windows service and verify that the service is started, 
as seen above. 

Verifying the ipmievd Service is Correctly 
Installed
This section describes how to verify that the ipmievd Windows service has 
been correctly installed to enable hardware monitoring. This procedure is an 
optional task and is not a necessary part of the installation procedure.

Before you start, ensure that you have successfully followed all the steps in 
the section Installing the ipmievd Windows Service.

Verification consists of finding an appropriate hardware sensor and injecting 
a hardware event to that sensor using the ipmitool utility. The ipmitool utility 
is available in the IPMItool for Microsoft Windows 2003 package downloaded in 
the previous section.

To verify the ipmievd service is correctly installed:

1. Open a command prompt window (cmd.exe) and change (cd) to the 
folder where you uncompressed the IPMI tool.

2. Depending on the installed operating system choose one of the 
following:

 On Windows Server 2003 SP1 or SP2 obtain a list of hardware 
sensors and events from the service processor by typing the 
following command:

ipmitool.exe -I ism -v sdr list

 On Windows Server 2003 R2 or Windows Server 2008 obtain a list 
of hardware sensors and events from the service processor by 
typing the following command:

ipmitool.exe -I ms -v sdr list
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3. Choose an appropriate sensor (Sensor ID) and hardware event that is 
Assertion Enabled and inject the hardware event. In this example, you 
inject the hardware event by typing:

ipmitool.exe -I ism event "ft1.fm2.prsnt" "Device 
Absent" assert

4. To verify that the ipmievd service writes this event in the Windows 
Application Log, click Start -> Administrative Tools -> Event Viewer 
and select Application log.

5. Verify that a message with ipmievd source is located in the log.

6. Double click on the selected event to view the details of the event.

Once the events are being correctly written into the Windows Application 
Log, the server is properly configured and can be monitored using the Sun
Servers Integration 2.3.
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─────
Installing the Microsoft IPMI Driver 
and Provider
This section describes how to install the Microsoft IPMI driver and provider to 
enable hardware management of a Sun x64 server running Windows Server 
2003 R2.

Ensure that you have one of the following Windows operating systems 
installed on your Sun x64 server:

 Microsoft Windows Server 2003 R2

 Microsoft Windows Server 2003 R2 SP2

Note - if a non R2 version of Windows Server 2003 is installed on the server, 
follow the steps described in Configuring Windows Server 2003 SP1 or SP2. 
The Microsoft IPMI driver is installed by default on Windows Server 2008.

To install the Microsoft IPMI driver and provider:

1. On the Sun x64 server running Windows 2003 R2 that you want to 
monitor, click Start -> Control Panel -> Add or Remove Programs and 
select Add/Remove Windows Components.

The Windows Components Wizard opens, as seen below.

2. Select Management and Monitoring Tools, click Details and select the 
Hardware Management component.
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3. Click OK and proceed with the following steps to install the hardware 
component.

4. Open the command prompt (cmd.exe) window and type the following 
command:

Rundll32 ipmisetp.dll, AddTheDevice

The Hardware Management component is now successfully installed.

To verify that the Hardware Management component has been installed, 
check the event viewer by clicking Start -> Administrative Tools -> Event 
Viewer and make sure the Hardware Events log is present.

To verify that the IPMI driver has been properly installed and that the driver 
has correctly detected the service processor, click Start -> Control Panel. In 
the control panel, double-click System, then in the Hardware tab click Device 
Manager. As seen in the image below, under System Devices you should see 
the Microsoft Generic IPMI Compliant Device.
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─────

Verifying the Microsoft IPMI Driver is 
Correctly Installed
This section describes how to verify that a Sun x64 server has been correctly 
set up for hardware monitoring using the Microsoft IPMI driver. Verifying the 
correct installation of the driver is an optional part of the configuration 
procedure.

Verification consists of finding an appropriate hardware sensor and injecting 
a hardware event on that sensor. These hardware events are injected using the 
ipmitool utility. The ipmitool utility is available as part of the IPMItool for  
Microsoft Windows 2003 package.

Before you start, make sure you have downloaded the latest IPMItool for  
Microsoft Windows 2003 package from:

http://www.sun.com/system-management/tools.jsp

Uncompress the IPMItool for Microsoft Windows 2003 package locally on the 
server to be monitored.

To verify the IPMI driver is correctly installed:

1. Open a command prompt window (cmd.exe) and change (cd) to the 
folder where you uncompressed the IPMItool for Microsoft Windows 
2003.

2. Obtain a list of hardware sensors and events from the service processor 
by typing the following command:

ipmitool.exe -I ms -v sdr list

3. Choose an appropriate sensor and hardware event that is Assertion 
Enabled, note the Sensor ID. For example, in the example we will 
choose the second Sensor ID, called Watchdog.
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4. To inject a hardware event, the following command is used:

ipmitool.exe -I ms event "Sensor ID" "Assertion" 
assert

where Sensor ID is the ID of the sensor taken from the previous step and 
Assertion is the type of assertion to inject.

5. You can also verify that the hardware event is written into the 
Windows Hardware Events log. Choose Start -> Administrative Tools 
-> Event Viewer and select Hardware Events log. Verify that a 
message with Microsoft-Windows-WSMAN-SEL_LogRecord source 
is located in the log.

6. Double-click on the selected event to view the details of the event. The 
Events Properties dialog opens.
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If step 5 completes successfully, the sever is properly installed and 
can be monitored by the Sun Servers Integration 2.3.
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CHAPTER     4     

Deploying Sun Servers Integration
2.3

This section explains how to install Sun Servers Integration 2.3 as well as how 
to verify configuration.

─────
Downloading the Sun Servers
Integration 2.3
Before you start, make sure you have downloaded the latest Sun Servers
Integration 2.3 from the following web site:

http://www.sun.com/system-management/tools.jsp

Save the Sun Servers Integration 2.3 to a working directory on the local 
system from which you plan to perform the installation and uncompress it.

─────
Installing Sun Servers Integration 2.3
Sun Servers Integration 2.3 is supplied as a executable setup.exe file, which 
installs all of the tools, Management Packs and utilities needed to completely 
integrate Sun x64 servers into Operations Manager.

Note � the Sun Servers Integration 2.3 installer is available for 32 bit and 64 bit 
architecture servers. Setup.exe is the 32 bit installer and setup_64.exe is the 64 
bit installer.

To install Sun Servers Integration 2.3:

1. Navigate to the folder you uncompressed Sun Servers Integration 2.3.

2. In the software folder run setup.exe or setup_64.exe depending on the 
server's processor architecture.

The Sun Servers Integration 2.3 installer opens.
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3. Click Next.

The License agreement opens.

Read the License agreement, click I agree with the license agreement 
and then click Next.
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4. The destination folder page shows the default path which the Sun
Servers Integration 2.3 will be installed to. Choose one of the following 
options:

If you want to install Sun Servers Integration 2.3 to the default path, 
click Next.

If you want to change the path which Sun Servers Integration 2.3 is 
installed to, click Change. A file browser opens and you can choose an 
alternative path, then click OK followed by Next.
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5. When you are sure you want to install Sun Servers Integration 2.3, click 
Install.

The installer opens various command line windows. The progress bar 
may not update accurately during the process of importing the 
management packs.

6. When the Sun Servers Integration 2.3 has finished, click Finish.

7. To verify that the Sun Servers Integration 2.3 management packs have 
been imported successfully, open the Operations Console and click 
Administration. Click Management Packs and in the list of available 
management packs look for packs with Sun Servers Integration as part 
of their name.

─────
Uninstalling Sun Servers Integration 2.3
Sun Servers Integration 2.3 can be uninstalled using standard Windows 
administrative tools. The uninstaller removes all of the installed software 
except the management packs. The management packs can be manually 
uninstalled by deleting them from Operations Manager.

To uninstall Sun Servers Integration 2.3:

1. In the Windows Control Panel, click Add or Remove Programs.

The list of currently installed programs opens.

2. In the list of currently installed programs, find the entry for Sun Servers 
Integration for Microsoft SCOM 2007. Click Change.
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The Sun Servers Integration 2.3 installer opens.

3. Click Next.

4. If you are sure you want to uninstall Sun Servers Integration 2.3, click 
Remove.

Sun Servers Integration 2.3 is uninstalled.
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By default the Sun Servers Integration 2.3 management packs are not 
uninstalled automatically. You can optionally uninstall the Sun Servers
Integration 2.3 management packs.

To uninstall the Sun Servers Integration 2.3 management packs:

1. In the Operations Console, under Administration open the list of 
Management Packs.

2. Click any Sun Servers Integration management pack except the Sun 
Servers - Library and under Actions click Delete.

Note - all of the model specific management packs depend on the Sun Servers 
- Library pack. The Sun Servers - Library management pack must be deleted 
last.

3. Repeat this process for each management pack starting with Sun 
Servers.

─────
Verifying Configuration
Once you have added the Sun Servers Integration 2.3 to your Operations 
Manager configuration and one or more Sun x64 servers have been 
discovered, you can confirm that the entire configuration is working properly 
using one or both of the following procedures:

 Manual verification: See Verifying Configuration Manually.

 Remote verification: See Verifying Configuration Remotely Using
IPMItool.

The following sections describe how to perform each of these procedures.

Verifying Configuration Manually
If you are located physically near one or more of your Sun x64 servers, you 
can verify configuration by generating a physical event. The most reliable way 
to accomplish this is to remove and re-insert a non-critical component.

Note - Before removing any component be certain that removal and re-
insertion of this component will not affect the normal and routine operation of 
the server. Verify that the redundant component is not critical to the current 
state of the system.

To test your configuration manually, do the following:

1. Locate the Sun x64 server in your data center.
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2. Identify a component on that system that is non-critical and hot-
pluggable (for example, a redundant power supply or fan tray).Remove 
the chosen non-critical component.

Note - Be certain to follow all required software and firmware procedures 
required for the safe removal of any hot-pluggable component. Consult the 
Sun manual or on-line information system that ships with your Sun x64 server 
for specific procedures related to removing the hot-pluggable component.

3. In the Operations Manager Event, Alert and Health Explorer views 
console, verify that removing the non-critical component has generated 
one or more hardware events.

4. Re-insert the non-critical component.

If you do not see the events in the Operations Manager Console, review this 
manual for required configuration steps or consult the Troubleshooting 
section.

Verifying Configuration Remotely Using 
IPMItool
Recent Sun x64 servers support an Integrated Lights Out Manager (ILOM) 
service processor. You can communicate with the ILOM service processors via 
their IPMI interfaces to have them generate non-critical, simulated events. If 
Operations Manager receives these non-critical, simulated events from ILOM, 
it is configured properly for actual events.

IPMItool is an open-source utility for managing and configuring devices that 
support the Intelligent Platform Management Interface (IPMI) version 1.5 and 
version 2.0 specifications. Versions of IPMItool are available for the Solaris, 
Linux, and Windows operating systems.

Operating System IPMItool Distribution(s)

Solaris

• Web: http://ipmitool.sourceforge.net/ 

• Solaris 10 image: IPMItool is available at /usr/sfw/bin.

• Software resource CDs: Often distributed with Sun x64 
servers.

Linux

• Web: http://ipmitool.sourceforge.net/ 

• Software resource CDs: Often distributed with Sun x64 
servers.

Windows

• Web: http://www.sun.com/  system-management/tools.jsp   

• Software resource CDs: Often distributed with Sun x64 
servers.

To verify that Operations Manager is configured to receive hardware 
events from a server supporting an ILOM:

1. Collect the following information about the remote service processor 
that you want to test.
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Field Description

<SPname>

The name or IP address of the service 
processor

Example: 192.168.1.1

<SPadminname>

The administrator login name for the 
service processor

Example: root

<SPadminpassword>

The administrator password for the service 
processor

Example: changeme

2. Enter the following IPMItool command to generate a list of all 
available sensors on the remote Sun x64 server:

# ipmitool -U <SPadminname> -P <SPadminpassword> \
-H <SPname> -v sdr list

For example, to get the list of available sensors on a Sun x64 server 
with a service processor at IP address 192.168.1.1, with a login of root 
and a password of changeme, type the following command:

# ipmitool -U root -P changeme -H 192.168.1.1 -v sdr 
list

3. In the output from IPMItool, identify the Sensor ID name of a sensor 
that has at least one entry in the Assertions Enabled or Deassertions 
Enabled fields.

In the following example, IPMItool returns the following information 
about the sensor named mb.t_amb, which monitors the ambient 
temperature on the server's motherboard.

Sensor ID : mb.t_amb (0x9)

Entity ID : 7.0 (System Board)

Sensor Type (Analog) : Temperature

. . .

Upper critical : 55.000

. . .

Assertions Enabled : lnc- lcr- lnr- unc+ ucr+ unr+

Deassertions Enabled : lnc- lcr- lnr- unc+ ucr+ unr+
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Note - Exercise caution in choosing a sensor to use for a simulated event. 
Simulating unrecoverable high or low temperature for some sensors may 
cause the server to shut down.

4. Enter the following IPMI command to generate a simulated event.

# ipmitool -U <SPadminname> -P <SPadminpassword> \
-H <SPname> event <sensorname> <option>

For example, to generate a simulated event for exceeding the upper 
critical (ucr) ambient temperature on a Sun x64 server with a service 
processor at IP address 192.168.1.1 and with an ILOM SP login of root 
and a password of changeme, type the following command:

# ipmitool -U root -P changeme -H 192.168.1.1 \
event mb.t_amb ucr assert

IPMItool returns information similar to the following:

Finding sensor mb.t_amb … ok

0 | Pre-Init Time-stamp | Temperature mb.t_amb | \

Upper Critical going high | Reading 56 > Threshold \

55 degrees C

5. In the Operations Manager event console, verify that an event from 
ILOM relevant to the sensor that you specified in your IPMItool 
command has been received.

6. (Recommended) Clear the simulated event with the following syntax:

# ipmitool -U <SPadminname> -P <SPadminpassword> \
-H <SPname> event <sensorname> <option>

7. To clear (deassert) the simulated event in the previous example, enter 
the following command:

# ipmitool -U root -P changeme -H 192.168.1.1 \
event mb.t_amb ucr deassert

If you do not see these messages in the console, review this manual for 
required configuration steps or see the Troubleshooting section.
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CHAPTER    5     

Monitoring Sun x64 servers in 
Operations Manager

This section explains the Sun-specific features available in Operations 
Manager after installing Sun Servers Integration 2.3 and how to use them to 
monitor your Sun x64 servers. An overview of the various views and how 
they apply to Sun x64 servers is also provided.

─────

Discovering Sun x64 Servers
Once you have installed Sun Servers Integration 2.3 you have to discover your 
Sun x64 servers, which have been configured as monitored nodes. Discovered 
Sun x64 servers are listed in the Operations Console Monitoring view under 
the Servers state, see Figure 1. For more information on discovering servers in 
Operations Manager, please see the Operations Manager documentation. You 
can optionally adjust how frequently Operations Manager discovers servers, 
please see Changing the Frequency of Server Discovery for more information.
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Figure 1: Monitored Servers State

If the Sun x64 server does not fulfill the requirements for being discovered, for 
example if an IPMI driver is not installed, it is displayed in the Operations 
Console Monitoring view under Servers state (not discovered). The Servers 
state (not discovered) view may display a possible reason for the Sun x64 
server not being discovered.
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Figure 2: Server Not Discovered

Once a Sun x64 server is discovered you can see various properties and 
launch Sun-specific servers tasks, for more information see Sun-specific Tasks. 
The next step for the discovered Sun x64 server is to become monitored. Sun
Servers Integration 2.3 provides monitors for every Sun x64 server sensor for 
supported platforms, including the knowledge base articles for sensors and 
events that indicate changes in the health state of the Sun x64 server.

It is always possible to monitor a supported machine regardless of the 
firmware version, however if it is not explicitly listed in the supported 
versions list, some events may not be displayed or translated and the 
discovered server will display a note in its properties. If the Sun x64 server is 
not supported, it will not be monitored at all. Sun x64 servers which fulfill the 
requirements , see Requirements for more information, are discovered and 
their static properties, such as SP IP address and so on are listed.

─────

Changing the Frequency of Server Discovery
By default the Sun Server Discovery Rules run every 12 hours. You can 
modify how frequently the Sun Server Discovery Rules run for supported 
servers so that your Sun x64 servers can be discovered with less delay. There 
is one Sun Server Discovery Rule for each supported server.
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Note - you should change the frequency of discovery when only necessary. 
Running discovery returns a large amount of data in a production 
environment with many monitored nodes.

To change how frequently a Sun Server Discovery Rule runs:

1. In the Operations Console, click Authoring.

2. In the Authoring pane, under Management Pack Objects click Object 
Discoveries.

The Object Discoveries list opens.

3. Optionally, type Sun into the Look for text box and click Find Now. 
This filters the Object Discoveries list to only show your Sun x64 
servers.

4. For each row with Discovered Type: Sun server model in the Object 
Discoveries list, click the Supported Sun Server Discovery row.

5. In the Actions panel, select Overrides -> Override the Object 
Discovery -> For all objects of type: Sun Server.

6. The Override Properties window opens. The Interval in seconds 
parameter can be modified to adjust the discovery frequency, measured 
in seconds.

7. Repeat this procedure for each row with Discovered Type: Sun server  
model in the Object Discoveries list.

8. In the Object Discoveries list, find the row Discovered Type: Sun 
Server and click the Sun Server Discovery row.
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9. In the Actions panel, select Overrides -> Override the Object 
Discovery -> For all objects of type: Windows Server.

Note - to disable discovery, the same steps can be taken. Instead of selecting 
Override the Object Discovery, select Disable Object Discovery.

─────

Sun x64 Servers Specific Views
The various views available after installing the Sun Servers Integration 2.3 for 
Operations Manager provide the ability to monitor the health status of your 
Sun x64 servers.

These views provide information about events that have happened, the task 
status, any state alerts, any Sun x64 servers that have not been discovered and 
the health of your Sun x64 servers.

Servers State View
The Servers state view provides an overall view of the status of a Sun x64 
server, together with its specific properties. To use the Servers state view, 
open the Monitoring section in the Operations Console. Then open the Sun 
x64 servers folder and select Servers state.

This view provides a list of your Sun x64 servers. Clicking on a specific server 
shows information such as the name, model, BIOS version, SP details and so 
on. The Servers state view also enables you to access the Sun-specific tasks 
available for your Sun x64 servers as part of Sun Servers Integration 2.3.

Sun-specific Tasks

Within the Servers state view, the following tasks are available for all Sun x64 
servers under the Sun servers tasks pane:

 Go to Sun systems integrations website - opens a web browser and 
navigates to the Integration with Third Party System Management 
ISV tools web page, where you can find the latest version of Sun
Servers Integration 2.3.

 Launch remote desktop - launches a remote desktop connection to 
the server currently selected in the Servers state view.

 Management console - opens the Microsoft Management Console for 
the server currently selected in the Servers state view.
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 Launch connection to ILOM - opens a web browser and displays the 
web-based GUI main page of the ILOM SP.

Note - to use the Launch connection to ILOM task, the Sun x64 server's SP 
must be connected to the network and be accessible from the management 
server.

When using the Management Console task, the task may fail if the Sun x64 
server and the management server are not in the same domain and there is no 
trust between them. The cause may be that additional log in credentials need 
to be provided. If you encounter this problem, run the cmdkey utility on the 
management server to assign login credentials for the Sun x64 server.

For example:

cmdkey /add:ServerName /user:ServerName\Administrator 
/pass:password

assigns the login credentials Administrator and password for the server 
ServerName. More information on the cmdkey utility can be found at:

http://technet.microsoft.com/en-us/library/cc754243(WS.10).aspx

Assigning ILOM SP Log In Credentials

To be able to use the Sun server tasks you need to configure Operations 
Manager to store the log in details for the ILOM SP.

Using Run As Profile enables you to use log in credentials to access the 
Service Processor (SP) of a Sun x64 server. Several Sun server-specific tasks 
are associated with the specific Run As Profile called SunSpAccessAccount. 
You have the option of associating Run As Accounts for the mentioned Run 
As Profile on a target computer.

Using Run As Account allows you to specify the necessary privileges for use 
with those tasks targeted to specific computers on an as-needed basis. Data is 
encrypted between the root management server and the targeted computer 
when credentials are being transferred and the credentials are securely stored 
on the targeted computer.

To assign login credentials for an ILOM SP:

1. Go to Administration and under Security click Run As Accounts.

2. Under Actions click Create Run As Account....

3. Click Next.

4. Type a Display name and select Basic authentication as the Run 
AsAccount then click Next.

5. Provide the login and password of the ILOM SP you want to monitor as 
the Account name and Password then click Create.

6. Go to Administration and under Security click Run As Profiles.

7. In the Run As Profiles tab, click Account for accessing the SP of Sun 
Server and under Actions click Properties.
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8. Select the tab Run As Accounts and then click New... to open the Add 
Alternate Run As Account dialog.

9. Under Run As account, select the previously created Run As Account 
created in step 5.

10.From the list of Matching Computers, select your management server.

11.Click Ok on both open dialogs to return to the Operations Console.

The log in details are now available in Operations Manager.

Management Server Tasks

Once you have the ILOM SP details available in Operations Manager you can 
use the management servers tasks to control your Sun x64 servers.

To access the management server tasks specific for Sun x64 servers:

1. In the Operations Console, open Monitoring -> Discovered Inventory.

2. Right-click in the discovered inventory window and select Change 
target type... -> Management server.

3. In the list of target types, select the Management server where the Sun
Servers Integration 2.3 has been installed.

The list of Sun x64 server specific tasks is shown in the Actions pane 
under Health Service Tasks.

Note - to use the following tasks, the SP of the server being managed must be 
connected to the network and be accessible from the management server.

Sun servers task Function

Graceful server shutdown Shuts down the operating system 
gracefully prior to powering off the 
selected Sun server.

SEL list Lists the contents of the System 
Event Log (SEL) of the selected Sun 
server.

Server power cycle Immediately reboots the selected 
Sun x64 server.

Server power off Forces a hard power off, only use 
when necessary.

Server power on Immediately turns on the power 
for the selected Sun x64 server.

Table 1: 

Running any of the Sun server tasks is similar. Before proceeding, you should 
ensure you have the SP's log in details available in Operations Manager, for 
more information see Assigning ILOM SP Log In Credentials.
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To run a Sun specific management server task:

1. In the Operations Console, open Monitoring ->Discovered Inventory. 
Under Actions is a group of tasks starting with Sun servers task:.

2. Click on the task name you want to use, the Run Task window opens.

3. Under Task Parameters, select ServiceProcessorIpAddress and click 
Override.

4. In the Override Task Parameters dialog, in the NewValue field type 
the IP address of the ILOM SP of the Sun x64 server that you want to 
run the task on.

5. Click Override, the ILOM IP is displayed under Value.

Note - the IP address of the ILOM SP can be obtained from the property SP IP 
of the discovered Sun x64 server. See Servers State View for more information.

6. Click Run and follow the information in the task output.
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Events View
Sun Servers Integration 2.3 provides an Operations Manager Events view 
with the Sun-specific information related to Sun x64 servers.

To open the Sun x64 hardware Events view choose the Monitoring section in 
the Operations Console, open the Sun x64 servers folder and click Events.

Every event on Sun x64 servers produced by the ipmievd service that is 
captured by the Application log is processed by Sun Servers Integration 2.3 
and shown in human-readable form in the Events list for the server.

Events with event number 999 indicate the Sun server component state by 
reporting the change of health for various server components.

Events with event number 888 indicate problems with particular server model 
discovery. Please see the corresponding event text for details about the error.
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Events with event number 777 indicate problems with the server health state 
and failure of processing events. Please see the corresponding event text for 
details about the error.

Active Alerts View
Sun Servers Integration 2.3 provides an the Active alerts view with Sun-
specific information related to the Sun x64 servers being monitored.

To open the Sun x64 hardware Alerts view, open the Monitoring section in 
the Operations Console. Then open the Sun x64 servers folder and select 
Active alerts.

The hardware alerts view can be seen in the image below.

When the monitor for a particular sensor switches to warning or critical state, 
it generates an alert. The alert is cleared automatically when the state of the 
monitor has changed back to normal. For detailed information about the 
monitor state that caused the alert, consult the monitor knowledge base.

Health Explorer
To identify a component that is affected by raised hardware alerts, the Health 
Explorer view can be opened.
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To open the Health Explorer for a particular server, open the Monitoring 
section of the Operations Console, select the desired server in any of the views 
and click Health Explorer in the right top actions panel.

The Health Explorer opens as shown in the image below.

The Health Explorer displays information about the health of Sun x64 Server 
components and critical Windows services. Each sensor has a unique monitor. 
Sensors are grouped by sensor type under aggregate monitors, one per sensor 
type. Health status details can be expanded to show a particular sensor that is 
in warning or critical state.

To get detailed information about the sensor that is being monitored, see its 
knowledge base, which also contains the information about the available 
states for the monitored sensor together with their severities, as in the 
following example.
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When a sensor has a critical state, an alert is generated with the corresponding 
severity.

Aside from hardware sensors, Windows services essential for monitoring of 
Sun x64 servers health are monitored. In this version of the integration, the 
ipmievd service is also monitored.

Task Status View
The Task Status view provides an overview of that tasks that have been run 
on the Sun x64 servers.

To open the Sun x64 servers Task Status view, open the Monitoring section in 
the Operations Console. Then open the All Sun x64 servers folder and select 
Task Status View.
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CHAPTER     6     

Troubleshooting

This section provides tips and solutions for the most common problems you 
may encounter when installing and using Sun Servers Integration 2.3. In 
addition you can find the release notes for the current version.

─────
Sun x64 Servers not Discovered
Check all of the necessary prerequisites mentioned in Requirements. Make 
sure you have followed the instructions appropriate to your server at 
Choosing a Configuration Procedure.

Possible reasons for your Sun x64 Server not being discovered by the 
integration pack are:

 The server is an unsupported Sun x64 server model and/or is using 
an unsupported firmware version. To see details about the server 
model and firmware versions supported by a particular pack, check 
the list of supported servers and firmwares at:

http://www.sun.com/system-management/tools.jsp

 The Sun IPMI driver, version 2.1 or higher is not installed on the 
Sun x64 server running Windows Server 2003 SP1 or SP2 that you 
want to monitor. For information on installing the Sun IPMI driver, 
see Installing the Sun IPMI Driver.

 The Microsoft IPMI driver and provider is not installed on the the 
Sun x64 server running Windows Server 2003 R2 that you want to 
monitor. For information on installing the Microsoft IPMI driver 
and provider, see Installing the Microsoft IPMI Driver and Provider.

 The ipmievd Windows service is not installed on the the Sun x64 
server running either Windows Server 2003 SP1, SP2, Windows 
Server 2003 R2 or Windows Server 2008 that you want to monitor. 
For information on installing the ipmievd Windows service, see 
Installing the ipmievd Windows Service.
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─────
Release Notes
This section contains late breaking information relating to the Sun Servers
Integration 2.3. Please also check the following web page for any updated 
information:

http://www.sun.com/system-management/tools.jsp

 If the service processor is restarted, all SEL messages are reread by 
Operations Manager. This can cause out of date messages, such as 
alerts and warnings, to reappear in Operations Manager. This can 
also cause the health of the server to be incorrectly reported.

 If the IPMI driver is not working on a Sun Fire X2250 Server make 
sure you have the latest BIOS installed. The ILOM firmware 
upgrade for Sun Fire X2250 Server does not automatically upgrade 
the BIOS. To solve this manually, upgrade the BIOS to at least 
version S86_3A16.

 With monitored nodes using ipmievd 1.8.10.2, if you encounter a 
problem with events appearing in the Event view, you can use the 
following command to check the SEL of the monitored node:

ipmitool -U <root> -P <changeme> – H <server> sel 
info

where <root> is the user name, <changeme> is the password 
and <server> is the server. If the returned SEL Information 
reports Overflow:true, then use the following command to clear the 
SEL:

ipmitool -U root -P changeme – H <server> sel 
clear

The Event view should start to display events correctly.

 When using a Sun X6450 server with ILOM version 2.0.3.10 build 
number 41273, Windows Server 2003 and the Sun IPMI driver 
version 2.1 you may encounter the following message:

This device is not working properly because 
Windows cannot load the drivers required for this 
device.

This is a known issue related to this specific combination of 
software and hardware and related to CR6899339. A work around 
for this issue is to upgrade the ILOM firmware to ILOM 3.

 When using a Sun Blade X6220 server module with ILOM version 
2.0.3.10 build number 36968, Windows Server 2008 you may 
encounter issues with the Microsoft IPMI driver in device manager. 
A work around for this issue is to upgrade the ILOM firmware to 
ILOM 3.
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